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Section 1: Introducing EndNote Online 

 EndNote Online, previously known as EndNote Web, is accessible over the Internet 

as part of our subscription to Web of Science and our licence for EndNote Desktop 

 You will need to register to set up an EndNote Online library 

 No extra fee is required to use EndNote Online off campus 

 You can save an unlimited number of references in EndNote Online 

 A plugin is available to allow EndNote Online to interact with Word 

 Most functions of EndNote Desktop are available in EndNote Online except that you 

are not able to edit styles, import filters or customise any settings 

 It is possible to create folders or groups of references and you can choose to share 

folders with other users 

 

Section 2: Registering to use EndNote Online  

To access the full functionality of EndNote Online, you must register via EndNote 

Desktop. 

From a University of Nottingham PC: 

 Click on the Start button 

 Click on All Programs 

 Click on EndNote 

 Click on the EndNote icon 

 Create a new desktop library or open an existing library 

 Click on the sync icon  

 Click on the sign up button 

 Enter your email address and then follow the instructions on screen to create a 
password. 

 Fields marked with a * are required 

 Please note the strict password guidelines: 

 

 You should see a screen stating EndNote Registration is complete 

 Click Sync 

 If prompted, click Yes to creating a compressed library backup 
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Signing up via the Web of Science 

If you have already signed up for additional features and alerts in the Web of Science, by 
setting up a personal login (an email address and password), the same login details will 

automatically allow you access to EndNote Basic via the web.  If you wish to upgrade your 

EndNote Basic account to EndNote Online, which enables you to gain access to additional 

storage space, output styles and database filters, follow the instructions below: 

 

 Open an existing, or create a new, EndNote Desktop library (see Section 2 above) 

 Once in EndNote Desktop, click on Edit, in the top menu bar 

 Click on Preferences 

 Click on Sync 

 Click on the Enable Sync button to upgrade 

 

 

 

 Enter the personal login you set up on the Web of Science (email address and 

password); this is now also your login for EndNote Online  

 Click on OK 

 If prompted, click Yes to creating a compressed library backup and Save 

 

Logging in 

Go to EndNote Online at: http://www.myendnoteweb.com 

 At the login screen, enter your email address and password for EndNote Online 

 Note: If you are off-campus you may initially be asked to login with your 

University computer username and password   

 

 

 

http://www.myendnoteweb.com/
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Section 3: Manually adding references  

 Click on the Collect tab 

 Click on New Reference 

 Select the appropriate Reference Type from the drop down menu 

 Fill in the template and Save the reference 

 

 

 

 

 

 

Section 4: Importing references from databases 

For information on how to download from the most commonly used databases, see the 

appendix at the end of this document. 

 

Section 4a: Direct export 

Importing references from the Web of Science 

The Web of Science is a multidisciplinary database covering journals and conferences 
relevant to the sciences, arts and social sciences.  It has a direct export function to both 

EndNote Online and EndNote Desktop. 

Access the Web of Science via NUsearch: 

 Go to the Library webpage at: http://www.nottingham.ac.uk/library/index.aspx 

and click on the NUsearch banner in the centre of the page 

 Click on Databases in the right hand menu, type Web of Science into the Name 
box and click on Find databases, then click on the Web of Science to access it 

 

Exporting references to EndNote Online: 

 Conduct a search and mark some relevant references by ticking the check boxes 

 Click on the Save to EndNote Online link at the top or bottom of the screen 

 Select the Record Content required, e.g. Author, Title, Source, Abstract; Full 
Record and Cited References 

 Click on Send 

 

Tips: Entering author names 

If you have more than one author, make sure that you enter each author on a 

separate line 

E.g.: Smith, John  
Thompson, Brian 

If you have a corporate author or body, enter a comma after the name to 

ensure that it displays correctly 
E.g.: Department of Health, 

http://www.nottingham.ac.uk/library/index.aspx
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Your Web of Science results page will refresh, and you should see that the references sent 

to your EndNote Online library are now marked . 

References sent to your EndNote Online library will be placed in both the Unfiled and All 

My References folders.  Click on either of these folders, or refresh the page, to see the 

references you have just sent. The SFX links are also transferred enabling you to easily 

connect to the full text if available.  

 

Importing references from NUsearch 

 Go to the Library webpage at: http://www.nottingham.ac.uk/library/index.aspx 

and click on the NUsearch banner in the centre of the page. 

 Sign in to NUsearch at the top of the page 

 Conduct a search 

 To export all the results displayed on the screen, select 

Add page to e-Shelf (under Refine, to the left of the 

screen) 

 To select individual references for export, click the star icon to the left of the 

reference; this will automatically add 
your reference to the e-Shelf 

 For references not displaying a star, 

click on either the title of the article, 

or click on View all versions, and 

then click the star icon 

 Click on e-Shelf at the top left of the screen 

 Select the references you wish to export to your EndNote Online library 

 From the drop-down menu in the right corner above your references, select Export 

to EndNote Web 

 Click on Go 

 

 

 

 You should see a screen confirming the number of references sent to you EndNote 

Online library 

 In EndNote Online click on either the Unfiled or All My References folder, or 

refresh the page, to see the references you have just sent.  The SFX links are also 

transferred enabling you to easily connect to the full text if available. 

 

 

http://www.nottingham.ac.uk/library/index.aspx


 7 

Section 4b: Non-direct export 

Importing references from the Library Online Catalogue (UNLOC) 

Some databases do not have a direct export option.  The Library Online Catalogue 

(UNLOC) is an example.   

This method involves two steps: 

1) Saving references as a text file 

2) Importing the file into EndNote Online using a filter 

 

Step1: Saving references as a text file 

 Access UNLOC at: http://www.nottingham.ac.uk/unloc, or from the Library 

webpage click on Discover our collections > Library catalogues > UNLOC 

 Perform a search and mark some relevant references 

 Click on the Save/Mail Selected option towards the top of the screen 

 Locate the heading Save set of records to disk  

 From the drop-down menu underneath this heading, select Reference 
management format – this will format the references to enable EndNote Online to 

import the appropriate details 

 Click on Save 

 Your references are now displayed in a tagged format for EndNote Online 

 

 
 

 If you are using Internet Explorer, click the  icon (Tools), File, then Save as…  

 If you are using Chrome, click the  icon (Customize and control Google 

Chrome), then select Save page as…  

 Choose a location to save your file to, e.g. your Z drive 

 Give your file a File name 

 From the Save as type drop-down menu, select text file (*.txt) or Text 

Document 

 Click on Save 

 

 

http://www.nottingham.ac.uk/unloc
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Step 2: Importing references into EndNote Online 

 Open your EndNote Online library 

 From the Collect tab, select Import References 

 

 

 

 Click on Select Favorites, then locate and highlight the RefMan RIS filter 

 Click on Copy to Favorites, then click on Hide to close the Favorites box 

 Click on Choose File to locate the text file of references you have just saved 

 Select the file and click on Open 

 From the Import Option drop-down menu, select the RefMan RIS filter 

 From the To drop-down menu, select [Unfiled]  

 Click on Import 

 You will see your references have been imported to an [Unfiled] group, click on 

[Unfiled] to view them 

 

 

 

 

Section 5: Importing details of webpages 

It is possible to import the details of a webpage directly into your EndNote Online library. 

 From the Options tab, select Download Installers 
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 Drag the Capture Reference button onto your Favourites bar in your browser; 

further help is detailed on the Download Installers page if needed  

 

  
 

 Go to the web page you wish to reference 

 Click the Capture Reference button you have saved on your Favourites bar 

 A dialogue box will open showing details of the web page you wish to save 

 

    

 

 Select my.endnote.com and then click Save To 

 You should see a screen confirming the web page reference was captured 

successfully 

 In EndNote Online click on either the Unfiled or All My References folder, to view 

the reference 

 

 

Section 6: Managing references 

 Click on the My References tab 

Note that the first folder listed is called All My References.  This contains all the 

references you have added to EndNote Online, and is automatically arranged in 

alphabetical order by author name. 



 10 

 

 

 

Editing a reference 

 Click on the title of a reference to open the full record 

 Click in the relevant fields to make any changes or additions to the details 

 

Sorting references 

References can easily be re-sorted by year or title by clicking on the relevant column 

headings.  Click a second time to reverse the order.  To return to author order, click the 

author column heading. 

 

Searching for references 

There is a Quick Search box on the left hand side of the screen where keywords, author 

names etc can be used to locate references. It is possible to use the wildcard * to find 
variant word endings.  You can search in All My References or choose a specific group 

from the drop-down list. 

 

Organising references into groups 

New groups can be created to collect together references on a particular topic.  

 Go to the Organize tab and to Manage My Groups 

 Create a group by clicking on New group and typing in a name (Note: You may be 

asked to allow scripted windows at this point; click on the yellow bar to temporarily 
allow, then click on New group again and retype the group name). 
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 Go to the My References tab to allocate references to your new group 

 Mark some references by clicking the left-hand boxes 

 Click on Add to group at the top of the screen 

 Select your new group from the drop-down list 

 Note: Records added to groups also remain in your master list of references (All My 

References). 

 

Sharing groups 

You can opt to share a group with another EndNote Online user. 

 Click on the Organize tab 

 Click on Manage My Groups 

 Select the group you wish to share 

 Click on the Manage Sharing button 

 

 

 

 Click on Start sharing this group 

 Type in the email address(es) of those with whom you wish to share your 
references 

 Specify whether you want the person to have Read only or Read & Write 

privileges 

 Click on Apply  

 

From the Organize tab and then Others’ Groups, you can link to groups being shared 
with you by other people.   

 

 

Discarding duplicate references 

As you import references from more databases you may find that some of your references 

are duplicated within your EndNote Library.  To discard your duplicate references: 

 Go to the Organize tab 

 Click on Find Duplicates 
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 You will see the duplicate references have automatically been ticked 

 Click on Delete to send the duplicates to your Trash folder 

 To completely delete the duplicates from your EndNote library, click on Empty 

 

 

 

 

Section 7: Linking to, attaching and viewing full-text 

It is possible to link to the full-text of journal articles from within EndNote Online, and 

also to manually attach PDFs to specific references. 

 

Linking to the full-text 

You can check for the availability of full-text articles from within EndNote Online by 

clicking on the SFX links imported from databases alongside your references.  If the 

University subscribes to the full-text of an article, you will be able to access it. 

 

 

Once you have found the full-text you can save it, often as a PDF, and then attach it 

manually to the relevant reference within your EndNote Online library (see Attaching 

PDFs to references section below). 
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Attaching PDFs to references 

 Click on the paperclip icon underneath the reference, then click on Attach files 
 

 
 

 Click on Choose File  

 Browse for the document, then click on Open 

 Click on upload 

 Click on Close 

 

       
 

 You should now see that the paperclip icon has turned from grey to blue to 

indicate that a document is attached to the reference 

 

  
 

 

Viewing PDFs 

 Click on the blue paperclip icon underneath the reference, then click on the 

filename to open the PDF 
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You can also access PDFs you have attached to references by clicking on the Organize 

tab, then Manage Attachments.  Click on the file name to open the document. 

 

 

 

Section 8: Creating a reference list 

 Click on the Format tab and then Bibliography 

 Click on the drop down menu next to References and select the relevant group of 
references 

 Click on Select Favorites, next to the Bibliographic style drop-down menu 
 

                                 
 

 Scroll through the alphabetical list of reference styles displayed and select a few 

relevant options, e.g. Harvard, Vancouver etc., then click on Copy to Favorites 

 Click on Hide to close the list of reference styles 

 

              
 

 Click on the drop down menu next to Bibliographic style and select a style you 
have just copied from the main alphabetical list 

 Click on the drop down menu next to File format and select an appropriate format, 

e.g. RTF (rich text file) 
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 Click on Preview & Print to display your list of references (Note: Pop-ups may be 

blocked at this point; if so, allow pop-ups, select your options again from the drop 

down menus and click Preview & Print to display your reference list) 

 Click on Print this Page 

 

                                     
 

 Alternatively, you can choose to Save your list of references, or send them to an 

E-mail address                          

 

Note: the bibliographic styles available in EndNote Online are similar to those in EndNote 
Desktop but they cannot be customised 

 

Section 9: Using EndNote Online with Word 2010 and 

2007 

To insert citations into Word documents from your EndNote Online library, and to format 

your bibliographies, an EndNote plug-in is required.  This plug-in has automatically been 

installed on University networked PCs.  However, to use EndNote Online with Word on a 
computer not connected to the University network, you will need to install the plug-in 

yourself. 

 Click on the Format tab and then on Cite While You Write Plug-in 

 You will see there are Installation Instructions available to help you, and options 

to download the plug-in for either Windows or Macintosh 

 

            

 

Inserting an EndNote citation into a Word document 

To open Word on University networked PC: 

 Click on the Start button 
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 Click on All Programs 

 Click on Microsoft Office 

 Click on Microsoft Word 

 Open an existing paper or begin typing a new paper 

 

You should see that an EndNote tab is available in the toolbar at the top of the screen.  If 

you cannot see this, close Word down and then re-open it.   

Note: Make sure your EndNote Online library is open when working with Word, and also 

make sure the appropriate EndNote tab is displaying in Word – to ensure Word links to 

your EndNote Online Library, you should make sure the Endnote Online tab is displaying 

 

 

To insert a citation: 

 Click on the EndNote tab 

 Click on Insert Citations in the top left-hand corner 

 A dialog box will open; search for the reference you require and then click on Find 

 Highlight the reference you need and then click on Insert 

 This will insert the reference within your text and begin creating the bibliography 

 Repeat the process to insert additional references;  then save your document 

 

 

Tip: If you need to switch the EndNote tab from Endnote X7 (Desktop version) to 

EndNote Online in the toolbar in Word:   
 Click on the EndNote tab 

 Click on Preferences in the far right column 

 Choose the Applications tab 

 Choose EndNote Online from the drop-down menu 

 Enter your email address and password for EndNote Online to login 

 Note: the tab for EndNote Online is simply headed EndNote 
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Formatting with a different bibliographic style:  

To format your reference list according to the reference style of your choice: 

 Click on the EndNote tab, and then click on the Style drop-down menu 

 

 
 

 You should see some default styles listed, such as Author-Date and Numbered, 

along with any additional styles you have previously selected as favourites 

 Select the style you want; both your in-text citations and bibliography will be 

reformatted in the referencing style you selected 

 To see a full list of reference styles, click on Select Another Style from the Style 

drop-down menu, and select the style you want to reformat your document   

 If you can’t see any further styles, you can select these from within EndNote Online 

itself: 

o Click on the Format tab 

o Click on Bibliography 

o Click on Select Favorites 

o Select your style(s) 

o Click on Copy to Favorites 

o The new styles should now display in both your EndNote Online Library,  and 

in your Style drop-down in Word 

 

 

 

Section 10: Syncing your EndNote Online and EndNote 

Desktop libraries 

You can set your EndNote Online and EndNote Desktop libraries to sync if you wish.  This 

means you can work with both systems. 

Note: You must set up sync from your EndNote Desktop library, and you must be 
registered on the most recent version of EndNote Online 

Tip: If you use both EndNote Desktop and EndNote Online, you can only select 
references from one or the other package when working with Word  
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To enable sync: 

 Open your EndNote Desktop library 

 Click on Edit, in the top menu bar 

 Click on Preferences 

 Click on Sync 

 Click on Enable Sync 

 Enter your EndNote Online username and password to upgrade to the most 
recent version of EndNote Online 

 

 

 Enter your email address and password for EndNote Online to login 

 Click on OK 

 If prompted, click Yes to creating a compressed library backup and Save 

You should then find that the same references are found within both your EndNote and 

EndNote Online libraries. 

 

 

 

 

 

 

If you are using a version of EndNote Desktop which is earlier than X6, the sync option is 

not available.  However you can export a file of your references from EndNote Online to 

your EndNote Desktop library.  

 Click on the Format tab and then Export References 

 Click on the drop-down menu next to References and select the relevant group of 
references you wish to export to EndNote Desktop 

 Click on the drop down menu next to Export style and select EndNote Export 

Tip: Sync one library only 

Do not sync more than one Desktop library with your EndNote Online library as 

there is the possibility that it could merge references from different libraries.  It 

is always recommended to have one EndNote Desktop library and to use the 
groups function to manage and organise your references. 
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Section 11: Using EndNote Online once you have left 
the University 

Whilst at Nottingham, you have access to the enhanced features of EndNote Online 

through the University’s site licence for the software.  Once you leave the University, you 

will have continued access to the references you have saved, but through EndNote Basic, 

the free version of EndNote Online.  EndNote Basic is still fully functional, but has fewer 

referencing styles and import filters.  You’ll find more information about EndNote Basic, 

including features and capacity at: http://endnote.com/product-details/basic.  

If you have used your University email address to register for EndNote Online we 
recommend that you change this to a personal email address before you leave the 

University to ensure continued access to EndNote Basic. 

From your EndNote Online library: 

 Click on the Options tab 

 Click on E-mail Address and enter your new email address 

 

Section 12: Further information 

FAQs – http://endnote.com/support/faqs 

Quick reference guide – http://endnote.com/sites/en/files/m/pdf/en-online-qrc.pdf  

For information on how to reference particular types of material, see: 

http://www.nottingham.ac.uk/studyingeffectively/writing/referencing/index.aspx   

If you have any further queries, please contact the Library Helpline: 

http://www.nottingham.ac.uk/library/help/libraryhelplineform.aspx or library-

helpline@nottingham.ac.uk. 

http://endnote.com/product-details/basic
http://endnote.com/support/faqs
http://endnote.com/sites/en/files/m/pdf/en-online-qrc.pdf
http://www.nottingham.ac.uk/studyingeffectively/writing/referencing/index.aspx
http://www.nottingham.ac.uk/library/help/libraryhelplineform.aspx
mailto:library-helpline@nottingham.ac.uk
mailto:library-helpline@nottingham.ac.uk
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Appendix 

 

Downloading from commonly used databases 

The table below shows how you would download from some of the more commonly 

used databases.   

Remember that databases can be provided by different suppliers.  Make sure you 
download the correct supplier’s filter.  If in doubt please contact the Library Helpline: 

library-helpline@nottingham.ac.uk. 

Currently, there may be differences in how you download if you are using a networked PC 

on-campus or a PC or laptop off-campus. 

 

From off-campus 

 Download the Microsoft Word Cite While You Write Plug-in, which also contains 

an export helper enabling most databases to import references directly 

 If you do not have EndNote Desktop on your computer, the references should 

download immediately into your EndNote Online library 

 If you are using both EndNote Desktop and EndNote Online on your computer, you 

will be prompted to select which library (EndNote Desktop or EndNote Online) you 

wish to download your references to 

 

On campus 

The plug-in is not currently downloaded onto University computers, so the direct download 

is not available. For most databases you will need to save a file and import into EndNote 
Online.  In cases where the database tries to import into EndNote only and does not allow 

you to save a file to import into EndNote Online, you should use the Firefox browser 

rather than Internet Explorer. 

More details about importing into the key databases are listed in the table below: 

 

            

mailto:library-helpline@nottingham.ac.uk
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Supplier Database Downloading from databases off 

campus 

Downloading from databases on 

campus 

Importing into EndNote Online     

CAS 

 

SciFinder  Click on export 

 Choose citation export format 

(*.RIS) 

 Click on Export 

 Click on Open 

 Enter your email address and 
password for EndNote Online 

References automatically imported 

 Click on Export 

 Choose Citation export format 

(*.RIS) 

 Click on Export 

 Click on Save as 

 Save as the default RIS formatted 
file 

 

From the Collect tab 

 Click on Import References 

 Browse for the saved .ris file 

 Click on Open 

 Choose the import option: 

RefMan RIS 

 Choose a group to import to  

 Click Import 

 

EBSCO  Business 

Source 
Premier 

 CINAHL 

 Historical 
Abstracts 

 

 Add references to folder 

 Go to Folder View 

 Click on Export 

 Choose Direct export to EndNote 

Web 

 Click on Save 

 Enter your email address and 

password for EndNote Online 

References automatically imported 

 

 Click on blue folder icon 

 Go to Folder View 

 Click on Export 

 Choose Direct export to EndNote 

Web 

 Click on Save 

 

References automatically imported 

Ei Ei Compendex 

(Engineering 

Village) 

 Click on Download 

 Select My PC under Location 

 Select EndNote (RIS, Ref. 
Manager) under Format 

 Enter your email address and 

password for EndNote Online 

References automatically imported 

 

 Click on Download 

 Select My PC under Location 

 Select EndNote (RIS, Ref. 
Manager) under Format 

 Click on Save 

 Click on Save as 

 Save as the default RIS formatted 
file 

 

 

 

From the Collect tab 

 Click on Import References 

 Browse for the saved .ris file 

 Click on Open 

 Choose the import option: 

RefMan RIS 

 Choose a group to import to  

 Click Import 
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Elsevier 

 

 

Science Direct 

 

 

 Click on Export 

 Export file: Select RIS (for 

EndNote, Reference Manager, 
and Procite) 

 Content: Select level of information 

you require 

 Click Export 

 Click on Open 

 Enter your email address and 
password for EndNote Online 

 

References automatically imported 

On Campus Use Firefox 

 Click on Export 

 Export file: Select RIS (for 
EndNote, Reference Manager, and 

Procite) 

 Content: Select level of information 
you require 

 Click Export 

 Click on Save as 

 Save as the default RIS formatted 

file 

From the Collect tab 

 Click on Import References 

 Browse for the saved .ris file 

 Click on Open 

 Choose the import option: 

RefMan RIS 

 Choose a group to import to  

 Click Import  

Elsevier 

 

Scopus  Click on Export 

 Choose RIS Format (EndNote, 
Reference Manager) 

 Choose the level of information you 

wish to be imported  

 Click on Export 

 Click on Open 

 Enter your email address and 

password for EndNote Online 

 

References automatically imported 

 Click on Export 

 Choose RIS Format (EndNote, 
Reference Manager)  

 Choose the level of information that 

you wish to be imported  

 Click on Export 

 Click on Save as 

 Save as the default RIS formatted 

file  

 

From the Collect tab 

 Click on Import References 

 Browse for the saved .ris file 

 Click on Open 

 Choose the import option: 
RefMan RIS 

 Choose a group to import to  

 Click Import 

Google Google Scholar 

 

 

 On the Google Scholar home page, 

go to Settings  

 Under Bibliography Manager, 

select Show links to import 

citations into EndNote 

 Click on Save 

 Search for your references 

 Click on Import into EndNote link 

On Campus Use Firefox 

There are two options: 

1) Changing Google Scholar settings: 

 Go to Settings on the home page 

 Under Bibliography Manager, select 

Show links to import citations into 
EndNote 

From the Collect tab 

 Click on Import References 

 Browse for the saved .ris file 

 Click on Open 

 Choose the import option: 

RefMan RIS 

 Choose a group to import to  
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 Click on Open  

 Enter your email address and 

password for EndNote Online 

References automatically imported 

 

 Click on Save 

 Search for your references 

 Click on the Import into RefMan link 

 Save the file 

 

2) Export from the publisher page 

 Click on the title link within your 

Google Scholar results to go to the 

publisher homepage 

Better export options may be available 

 Click Import 

IEEE IEEE Xplore  Mark references 

 Click on Download Citations 

 Output Format: EndNote, 

Reference Manager, ProCite 

 Click on Download 

 Click on Open 

 Enter your email address and 
password for EndNote Online 

References automatically imported 

On Campus Use Firefox 

 Mark references 

 Click on Download Citations 

 Output Format: EndNote, Reference 
Manager, ProCite 

 Click on Download 

 Click on Save File 

 Click on OK 

 

From the Collect tab 

 Click on Import References 

 Browse for the downloaded folder 

(probably within My Documents 
and Downloads) 

 Click on Open 

 Choose the import option: 
RefMan RIS 

 Choose a group to import to  

 Click Import 

NLM PubMed There are 2 options: 

1) Searching within PubMed 

 Mark references 

 Click on Send to 

 Choose Citation manager 

 Click on Create File 

 Enter your email address and 

password for EndNote Online 

References automatically imported 

On Campus Use Firefox 

There are 2 options: 

1) Searching within PubMed 

 Mark references 

 Click on Send to 

 Choose Citation manager 

 Click on Create File 

 Click on Save File 

 Click on OK  

 

 

From the Collect tab 

 Click on Import References 

 Browse for the downloaded folder 
(probably within My Documents 

and Downloads) 

 Click on Open 

 Choose Pubmed (NLM) filter 
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2) Searching from EndNote Online  

 From the Collect tab, click on Online 

Search 

 Choose PubMed  

 Click on Connect 

 Enter your search 

 Choose whether you want all 

references retrieved or a range of 

references 

 Click on Search 

 Click on Retrieve (Note: there is no 

way to view the references you find 

before they are imported) 

 

 

 

2) Searching from EndNote Online 

 From the Collect tab, click on Online 

Search 

 Choose PubMed  

 Click on Connect 

 Enter your search 

 Choose whether you want all 

references retrieved or a range of 

references 

 Click on Search 

 Click on Retrieve (Note: there is no 

way to view the references you find 

before they are imported) 

 Choose a group to import to  

 Click Import 

OvidSP 

 

 

Various databases 
including: 

 AMED  

 CAB 

Abstracts 

 Embase 

 Food science 

& technology 
abstracts 

 Inspec 

 International 
Pharmaceutic

al Abstracts 

 Medline 

 PsycInfo 

 Click on Export 

 From the Export To drop-down 

menu, choose EndNote 

 Choose the amount of information to 

export (it may work better if you 
select Complete Reference) 

 Click on Export Citations 

 Enter your email address and 
password for EndNote Online 

References automatically imported 

Some manual editing may be required 
(see final column) 

 

 Click on Export 

 From the Export To drop-down menu, 

choose: Reprint/Medlars 

 Choose the amount of information to 

export (it may work better if you 
select Complete Reference) 

 Click on Export Citations 

 Click on Save as 

From the Collect tab 

 Click on Import References 

 Browse for the saved file 

 Choose the import option for the 

database name (e.g. Medline 
OvidSP, AMED OvidSP etc.) 

Some manual editing may be 

required. E.g. when downloading 
from CAB Abstracts the year may be 

missing, or when downloading from 

INSPEC, the volume, year and pages 
are not always put in the correct field 

(Exporting the complete reference 

rather than just the citation may 
solve this.) 

 Choose a group to import to  
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 Click Import 

Proquest 

 

 

Various indexes 

including:  

 ABI/Inform 

 ASSIA 

 Biological 

Sciences 

 British 
Humanities 

Index 

 Environment
al Science  

 Medline etc. 

You may first need to disable pop up 

blockers (tools > popup blocker > turn 

off popup blocker, or, internet options > 

privacy > untick turn on pop up blocker) 

 Click on More 

 Click on RIS (works with EndNote 

… etc.) 

 Scroll to the bottom of the window 

and click on Continue  

 Click on Open 

 Enter your email address and 

password for EndNote Online 

On Campus Use Firefox 

You may first need to disable pop up 

blockers (tools > popup blocker > turn off 

popup blocker, or, internet options > 
privacy > untick turn on pop up blocker) 

 Click on More 

 Click on RIS (works with EndNote 
… etc.) 

 Scroll to the bottom of the window 

and click on Continue 

 Click on Save File 

 Click on OK 

 

From the Collect tab 

 Click on Import References 

 Browse for the downloaded folder 

(probably within My Documents 
and Downloads) 

 Click on Open 

 Choose the import option: 
RefMan RIS 

 Choose a group to import to  

 Click Import 

Thomson 

(TS) 

Web of Knowledge 

including: 

 Web of 

Science 

 BIOSIS 

 Zoological 

records 

 

 

 Click on Save to EndNote online 

 Enter your email address and 
password for EndNote Online 

 Choose the amount of information to 

export 

 Click on Send 

References automatically imported 

 Click on Save to EndNote online 

 Choose the amount of information to 
export 

 Click on Send 

 Enter your email address and 
password for EndNote Online 

Correct import filter is selected 

automatically 

 


